
6.1 

Customizing E-Mail 
After completing this lesson, you will be able to: 

� Specify e-mail options. 

� Customize the appearance of e-mail messages. 

� Add a signature to an e-mail message. 

� Set viewing options. 

� Sort messages. 

� Create folders. 

� Move messages between folders. 

� Filter junk e-mail messages. 

As the popularity of the Internet increases, it’s easy to become overwhelmed 

with e-mail messages from friends, family, and coworkers. You can make your 

e-mail more manageable by identifying, prioritizing, and storing the messages 

that you receive. If you use e-mail regularly and you receive a dozen messages 

or more per day, over time it can become difficult to find a particular message 

in an Inbox that contains hundreds of received messages. However, if you 

customize and organize the e-mail messages you send and receive, locating the 

right information is a simple process. 

You can easily customize e-mail messages in Microsoft Outlook by applying 

specific options to your message. Available options include attaching a level of 

importance or sensitivity to a message, automatically sending replies to others, 

and saving sent messages to a specified folder. You can also set options that 

delay the delivery of a message. (For example, you can compose a birthday 

greeting to a friend but not have it sent until the recipient’s birthday.) Another 

option makes a message invalid after a specified date. Other options include 

receiving notification when an e-mail message is read by the recipient, linking 

a message to a contact, and assigning a message to a category. 

You can also customize e-mail messages by changing their appearance. In older 

e-mail programs, you were restricted to sending messages using only plain text, 

without text-formatting, color, or graphics capabilities. Most of today’s 

programs include many of these capabilities. Using Microsoft Outlook, you can 

enhance your e-mail messages by placing images in the background, adding 

borders, using different fonts and colors, and formatting text. You can further 

customize your e-mail messages by adding a personalized signature, which is 

inserted at the end of an e-mail message. In a signature, you might include 

information such as your title, phone number, and e-mail address. You can also 

include graphics, such as your organization’s logo. 

Organizing messages in your Inbox is another way to manage your e-mail. It is 

easier to find a specific message and reduces the clutter in your Inbox. You can 

organize messages by displaying them in a specific sequence, moving them to 
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different folders, deleting messages you no longer need, and color-coding your 

messages. For example, you can move unwanted e-mail messages from 

advertisers to the Deleted Items folder, or remove old messages from the Inbox 

by placing them in a storage folder or deleting them. 

In this lesson, you will learn how to customize outgoing messages by adding 

options, backgrounds, images, borders, and a personal signature. You will learn 

how to view your messages by sender, subject, time, and other criteria. You 

will also learn how to create folders to organize and store messages by specific 

topics or projects. In addition, you will learn how to sort and store messages 

that are important to you. 

No practice files are required to complete the exercises in this lesson. 

important 

To complete some of the exercises in this lesson, you will need to 

exchange e-mail messages with a class partner. If you don’t have a class 

partner or you are performing the exercises alone, you can send the 

message to yourself. Simply enter your own e-mail address instead of a 

class partner’s address. 

Specifying E-Mail Options 

Several options enable you to specify how messages are sent and where they 

are stored. For example, you can alert recipients that your e-mail message is 

more important than normal messages or inform recipients that the message 

contains sensitive information. You can set Outlook to forward a reply to other 

people or save your sent message in a particular folder. You can select the day 

and time the message is sent and alert the recipient when the message is no 

longer relevant. 

To select options for an e-mail message, create a new message. Click the 

Options button on the Message toolbar in the message window. The Message 

Options dialog box is displayed. 

Your Outlook folders should 

already contain the Outlook 

items (e-mail messages and 

contact records) that are 

necessary to complete the 

exercises in this lesson.  
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The e-mail options in the Message Options dialog box are explained in the 

following table. These selections are applied to the message you are currently 

creating. 

Option Description 

Importance Marks an e-mail message to be of high or low impor-

tance. When a message marked high is received in 

Outlook, the message header displays a red exclamation 

point in the Importance column of the message header. 

A message of low importance displays a blue down 

arrow in the Importance column of the message header. 

All other e-mail messages are con-sidered to be of 

normal importance and no icon will be displayed in the 

Importance column when they are received. 

Sensitivity Recommends how the recipient should regard the  

e-mail message. You can mark messages as Normal, 

Personal, Private, or Confidential. A warning appears at 

the top of Personal, Private, and Confidential messages, 

stating the sensitivity of the e-mail message. Sensitivity 

doesn’t restrict access to the message and shouldn’t be 

considered a form of security. 

Security Settings Assign additional security measures, such as encryption 

and a digital signature, to the message.  
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Option Description                            (continued) 

Use voting 

buttons 

Enable recipients to vote by selecting one of several 

choices. Use the standard button names or assign 

custom names to the buttons. This option requires 

Microsoft Exchange Server. 

Request a 

delivery receipt 

for this message 

Select this option to receive notification when the 

message is delivered to the recipient’s Inbox. 

Request a read 

receipt for this 

message 

Select this option to receive notification when the 

recipient has read the message. When the recipient 

opens the message, an alert box asks if Outlook can 

notify the sender that he or she read the message. If the 

recipient agrees, Outlook sends an e-mail message to 

the sender, stating when the message was read. 

Have replies  

sent to  

Message replies are automatically sent to the specified 

e-mail addresses. For example, if you send a message 

that requests more information about a particular topic, 

you can specify that the reply be sent to others who 

would also benefit from the information. 

Save sent 

message to 

When you send an e-mail message, a copy of the 

message is automatically saved in the Sent Items folder. 

Select this option to save a copy of the sent message in 

a folder that you specify. 

Do not deliver 

before 

Delay delivery of an e-mail message until a later date or 

time. For example, on Monday, the marketing director 

at Adventure Works scheduled a meeting for Friday 

morning. When she scheduled the meeting, she created 

a message to be delivered on Thursday morning that 

included attached documents for attendees to review 

before the meeting. 

Expires After Some messages expire; they become invalid after a 

specific date. Include expiration dates for time-sensitive 

messages, such as invitations and deadlines. An expired 

message is dimmed or crossed out in the recipient’s 

Inbox after the message has expired. An expired 

message that has not been read is dimmed, but the 

message can still be opened. Expired messages that 

have been read have a line through them to indicate that 

they have expired. Messages expire at the preset time of 

5:00 P.M. (the end of the business day). To change the 

preset time, delete it and enter a new time. 
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Attachment 

format 

Attachments stored on your computer can be mapped to 

and readable on the Internet. Default uses the most 

common format for the attachment. 

Encoding Select this option to use mappings from the Windows 

character sets to alter Internet format for different 

languages. 

Contacts Select this option to link contacts to e-mail messages. 

For example, link the contact for the customer service 

manager to an e-mail message sent from a satisfied 

customer. 

Categories Select this option to assign the message to a category. 

Categorizing messages makes it easier to find and 

group related messages. 

In this exercise, you create a new message, mark the message as high priority, 

and send it to your class partner. You create another message, mark it as 

Confidential, and send it to your class partner. 

1 If necessary, click the Inbox shortcut on the Outlook bar. 

The contents of the Inbox folder are displayed. 

2 On the Standard toolbar, click the New Mail Message button. 

A message window is displayed. 

3 On the Message toolbar in the message window, click the Options 

button. 

The Message Options dialog box is displayed. 

4 In the Message Settings section, click the Importance down arrow, 

and click High. 

5 Click the Close button. 

The Message Options dialog box closes. 

6 In the To box, type your class partner’s e-mail address and press 

the Tab key twice. 

The insertion point moves to the Subject box. 

7 In the Subject box, type Health Insurance Files and press Enter. 

The insertion point moves to the message area. 

8 Type Review all health insurance files for inaccuracies. 

9 On the Message toolbar in the message window, click the Send 

button. 

The message is sent to your class partner. 

10 On the Standard toolbar, click the New Mail Message button. 

A message window is displayed. 

If you send the e-mail 

message to a recipient who 

also uses Outlook, any flags 

or other settings that you 

specified are displayed in the 

recipient’s message. Flags 

and other settings might not 

be displayed in the message 

if the recipient uses an e-mail 

program other than Outlook. 
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11 On the Message toolbar in the message window, click the Options 

button. 

The Message Options dialog box is displayed. 

12 In the Message Settings section, click the Sensitivity down arrow, 

click Confidential, and click the Close button. 

The Message Options dialog box closes. 

13 In the To box, type your class partner’s e-mail address, and press 

Tab twice. 

The insertion point moves to the Subject box. 

14 In the Subject box, type Paycheck, and press Enter. 

The insertion point moves to the message area. 

15 Type Look for a $500 bonus in your next paycheck. 

16 On the Message toolbar in the message window, click the Send 

button. 

The message is sent to your class partner. 

17 On the Standard toolbar, click the Send/Receive button. 

Two messages from your class partner arrive in the Inbox. Notice 

that a red exclamation point is displayed to the left of the Health 

Insurance Files message header. 

18 Double-click the message Paycheck. 

The message window opens. Notice that the comment at the top of 

the message window states that the message is confidential. 

 

19 In the top-right corner of the message window, click the Close 

button. 

The message window closes. 
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Customizing the Appearance of E-Mail 
Messages 

In older e-mail programs, you were limited to sending e-mail messages in plain 

text that used only a few fonts. With Outlook, you can send e-mail messages 

with graphical backgrounds and formatted text. Formatted text appears in 

different sizes, colors, styles, and alignments. You can use these formatting 

options to customize a message for a particular event or recipient. For example, 

an e-mail invitation to a corporate shareholders meeting requires a neutral 

background with a formal font, but an e-mail invitation to a birthday party 

needs a colorful background with text in a larger, more ornate font. 

Outlook includes three message formats for sending and receiving messages: 

HTML, Rich Text, and Plain Text. 

■ HTML is an acronym for Hypertext Markup Language, which is the 

formatting language used by Web browsers to format and display 

Web pages. Use HTML if you want to use text formatting, 

numbering, bullets, alignment, horizontal lines, backgrounds, 

animated graphics, pictures, and entire Web pages. Not all e-mail 

programs can display HTML formatting. 

■ Rich Text is a standard method of formatting text with tags that can 

be understood by most word processors and newer e-mail 

programs. Use Rich Text if you want to use text formatting, bullets, 

and alignment. Rich Text can’t support the extensive Web 

capabilities of the HTML format such as animated graphics and 

Web pages. Not all e-mail programs can display Rich Text 

formatting. 

■ Plain Text is generic text that can be read by any e-mail program. 

Use Plain Text when you do not want to include any formatting in 

your messages. Plain Text is the safest option because all e-mail 

programs can read text in this format. 

Specify one of the three message formats as a default format that is used for all 

your messages. However, you can always switch to another message format for 

an individual message. Outlook uses the format of a received message as the 

format for your reply message. For example, if you reply to a message sent to 

you in plain text, Outlook creates a reply in plain text format. This reduces the 

chance that your reply will use formatting or graphics that can’t be displayed 

correctly by the correspondent’s e-mail program. 

You can also change how your replies and forwarded messages are formatted 

and how the original text is included in the message, if at all. Use the On replies 

and forwards section of the E-Mail Options dialog box to change the 

appearance of replies and forwards.  

When you click a reply or 

forward option in the E-Mail 

Options dialog box, a preview 

of the reply or forward 

appears to the right of the 

selected option. 
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The following table identifies the reply and forward options. 

Option Description 

Do not include original 

message 

The message consists of your response only; the 

original message does not appear with the reply. 

This option is useful if you want to send short 

replies to a recipient who will have no difficulty 

understanding your response. This option is not 

available when forwarding a message, because 

you want the original message text to be 

displayed. 

Attach original message The original message is included as an attachment 

to the reply or forwarded message. 

Include original message 

text 

The text of the original message is included 

below your comments in the reply or forwarded 

message. 

Include and indent 

original message text 

The text of the original message is indented under 

your comments. This option helps you distinguish 

the text of the original message from the text you 

add. 

Prefix each line of the 

original text 

The text of the original message is included in the 

reply or forwarded message. You can select the 

special character, usually a “>”, that is inserted 

before each line of the original text. 

In this exercise, you change the format of your replies so that the text of the 

original message is sent as an attachment and your outgoing e-mail messages 

are sent in Rich Text. You create an e-mail message, send it to your class 

partner, reply to a message from your class partner, and view a reply to your 

message. 

1 On the Tools menu, click Options. 

The Options dialog box is displayed. 

2 Click the E-Mail Options button. 

The E-Mail Options dialog box is displayed. 

3 In the On replies and forwards section, click the When replying to a 

message down arrow, click Attach original message, and then click 

OK. 

The E-Mail Options dialog box closes. 
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4 In the Options dialog box, click the Mail Format tab. 

5 In the Message format section, click the Compose in this message 

format down arrow, click Rich Text, and click OK. 

The Options dialog box closes. 
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6 On the Standard toolbar, click the New Mail Message button. 

A message window is displayed. 

7 In the To box, type your class partner’s e-mail address, and press 

Tab twice. 

The insertion point moves to the Subject box. 

8 Type Going Away Party and press Enter. 

The insertion point moves to the message area. 

9 In the message area, type Please come to the AW pavilion for 

Frank’s going away party. RSVP and select the text. 

The selected text is highlighted. 

10 On the Formatting toolbar in the message window, click the Font 

down arrow, scroll down, and click Monotype Corsiva. 

The font Monotype Corsiva is displayed in the Font box and the 

selected text is modified. 

11 On the Formatting toolbar in the message window, click the Font 

Size down arrow, and click 20. 

The font size is set to 20 points and the selected text is modified. 

If you don’t see the Monotype 

Corsiva font in the list, 

choose another font that 

appeals to you. 
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12 On the Formatting toolbar in the message window, click the Font 

Color button, and select the Dark Red square (first square in the 

second row). 

The font color is set to dark red and the selected text is modified. 

 

13 On the Message toolbar in the message window, click the Send 

button. 

The message is sent to your class partner. 

14 On the Standard toolbar in the Inbox folder, click the Send/Receive 

button. 

A message from your class partner arrives in your Inbox. 

15 In the Inbox, double-click the message Going Away Party sent by 

your class partner. 

The message window is displayed. 

16 On the Standard toolbar in the message window, click the Reply 

button. 

A reply window appears. Notice that the original Going Away Party 

message is now an attachment. 

17 In the message area, type I will be there. Click the Send button on 

the Message toolbar in the reply window. In the upper-right corner 

of the message window, click the Close button. 

The reply is sent to your class partner and the reply window closes. 

18 On the Standard toolbar, click the Send/Receive button. 

A message from your class partner arrives in the Inbox. 

19 Double-click the reply from your class partner and double-click the 

Going Away Party attachment icon. 

The original message is displayed in its own window. 

20 In the top-right corner of each open window, click the Close button. 

The windows close. 
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Adding a Signature to an E-Mail 
Message 

Many people include contact information at the end of each message they send. 

Rather than typing this information every time, create a signature that Outlook 

adds to the end of all messages you send. Signatures usually include your name 

and e-mail address. You can include information such as a phone or fax number 

and your title. Company logos and other graphics can also be added to a 

signature. Select colors and fonts to create a unique and expressive signature. 

For example, one of the managers at Adventure Works ends her e-mail 

messages with a business signature, which includes her name, title, business 

name, phone number, and the Adventure Works logo. 

 

Create as many signatures as you need. In addition to a business signature, 

create a personal signature that includes your nickname or a favorite quote. 

Create a simple signature for messages sent in Plain Text format and create a 

more complex signature with a logo for messages sent in HTML or Rich Text 

format. Set up Outlook to automatically insert a signature in the message area 

or select which signature you want to use in a message. To select a signature in 

a new message window, open the Insert menu, point to the AutoText, point to 

the Signature option, and select the signature. 

In this exercise, you create a signature. You use the signature when you send a 

message to your class partner. 

1 On the Tools menu, click Options. 

The Options dialog box appears. 

2 Click the Mail Format tab. 

3 Click the Signatures button. 

The Create Signature dialog box is displayed. 

If your signature contains 

colors or fonts, and you 

change the format of your 

message to Plain Text, the 

appearance of your signature 

also changes. 
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4 Click the New button. 

The Create New Signature dialog box is displayed. 

5 In the first box, select the default text Untitled. Type class 

signature. 

The name is assigned to the new signature. 

Existing signatures may be 

listed in the Create Signature 

dialog box. 
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6 Verify that the Start with a blank signature option is selected. 

7 Click the Next button. 

The Edit Signature dialog box is displayed. 

8 Type your name and press Enter. Type Outlook Class. 

9 Click Finish and click OK in each dialog box to return to the Inbox. 

When you create a new e-mail message, your signature is 

automatically placed in the message area. 

10 On the Standard toolbar, click the New Mail Message button. 

A message window is displayed. The class signature you created is 

already placed in the message area. 

11 In the To box, type your class partner’s e-mail address and press 

Tab twice. 

The insertion point moves to the Subject box. 

12 In the Subject box, type Outlook Expert and press Enter. 

The insertion point moves to the message area. 

13 Type Are you going to take the Outlook Expert course? 

14 On the Message toolbar in the message window, click the Send 

button. 

The message is sent to your class partner. 

15 On the Standard toolbar, click the Send/Receive button. 

A message from your class partner arrives in your Inbox. 

16 Double-click the Outlook Expert message header. 

The message window opens. Notice the sender’s signature below 

the text. 

In the Edit Signature dialog 

box, you can change the 

appearance of your 

signature. Select the text, 

click the Font or Paragraph 

button, and select formatting 

options. 

In the Inbox, select Options 

from the Tools menu. Click 

the Mail Format tab. Your 

new class signature is 

selected in the Signature for 

new messages box. If you no 

longer want this signature to 

be placed in all new 

messages, select None or 

choose a different signature. 

Not all e-mail programs can 

display all the fonts that are 

available in Outlook or in your 

installation of Microsoft 

Windows. Similarly, if you 

receive a message that 

contains a font that you do 

not have installed, Outlook 

substitutes a font that is 

installed. 
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17 In the top-right corner of the message window, click the Close 

button. 

The message closes. 

Setting Viewing Options 

The Inbox can be displayed in several different views, or groups, to help you 

locate messages. For example, group your messages by sender so all messages 

from your supervisor are displayed together. If your Inbox contains dozens or 

hundreds of messages, you can change your Inbox view so only the unread 

messages are displayed. 

By using different views, you can find particular messages faster and easier. 

You can also see the relationships among different messages, the rate of e-mail 

correspondence, and the date and time at which you sent and received an e-mail 

message. 

In most views, messages are displayed in a table format with the following 

columns at the top of the Inbox window: Importance, Icon, Flag Status, 

Attachment, From, Subject, and Received. When you view messages in the By 

Conversation Topic, By Sender, or By Follow-Up Flag view, the messages are 

divided into groups. The groups are divided by expandable gray bars that 

summarize each group. For example, if you display your messages in the By 

Sender view, instead of seeing the messages, you see several gray bars that 

display the text From: (name of sender) ([number] Items, and [number] 

Unread). If you receive four messages from Adventure Works and you read 

three of them, the gray bar displays this information about the messages. To 

display or hide the messages in the group, click the plus sign or the minus sign 

on the gray bar. The ability to hide and show messages is just another way to 

help you locate the messages that you want to see. 

 

The following table details each view. 

View Description 

Messages This is the default view for the Inbox. Message headers 

are arranged in a table with seven columns: (from left to 

right) Importance, Icon, Flag Status, Attachment, From, 

Subject, and Received. 

Messages with 

AutoPreview 

Message headers are arranged in a table and 

AutoPreview is used by category. From one to three 

lines of the body of the message appear under the 

message header. 

By Follow-Up Flag Messages are sorted by Follow-Up Flag. Messages with 

flags are grouped. Also, a new column, Due By, has 

been added. 
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View Description                            (continued) 

Last Seven Days Messages received in the last seven days are displayed. 

Use this view to see only the most recent messages. 

Flagged for Next 

Seven Days 

Messages that have a Due Date within the next seven 

days are displayed. Use this view to see messages 

requiring the most urgent attention. 

By Conversation 

Topic 

E-mail messages and replies are grouped according to 

message threads (a sequence of replies regarding a single 

topic). A conversation topic is the subject of the original 

message in a message thread. Use this view if you have 

several replies to original messages. For example, if you 

and a coworker have exchanged messages about a 

company event, the replies concerning the original 

message are indented under the original message in the 

order they were received. 

By Sender E-mail messages are sorted by the sender’s e-mail 

address. Use this view to see all e-mail correspondence 

with a particular person or address. 

Unread Messages Only e-mail messages that have not been opened and 

read are displayed. Use this view if your Inbox contains 

a combination of read and unread messages. 

Sent To Sort messages by the recipient’s address. Use this view 

to see messages you sent to a specific person or e-mail 

address. 

Message Timeline Messages are displayed on a timeline organized by the 

time they were sent and received. Double-click a 

message header to open a message. The timeline 

increments can be viewed by day, week (the default 

timeline view), or month. To change the timeline 

increments click the Day, Week, or Month button on the 

Standard toolbar. Use this view to review your e-mail 

correspondence over time. 

In this exercise, you change the Inbox view from the default Message view to 

the By Sender view, the Unread Messages view, and the Message Timeline 

view. 

1 On the Standard toolbar, click the Organize button. 

The Using Folders section of the Organize pane is displayed. 

2 Click the Using Views option. 

The list of available views is displayed. Use this list to change the 

appearance and organization of messages. 
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3 In the Change Your Views list, click By Sender. 

The message headers are grouped in a table by sender. All the 

messages from your class partner are grouped in a gray bar 

identified by your class partner’s name. The number of messages 

in the group is displayed. 

4 At the left end of your class partner’s gray bar, click the plus sign 

(+). 

The e-mail messages from your class partner are displayed and the 

plus sign (+) is now a minus sign (-), indicating that the view has 

been expanded. 

5 At the left end of your class partner’s gray bar, click the minus sign 

(-). 

The e-mail messages from your class partner are hidden and the 

minus sign (-) is now a plus sign (+). 

6 Click the plus sign at the left end of a different gray bar to view the 

messages. 

7 In the Change Your View list, click Unread Messages. 

All unread messages are displayed. 

8 In the Change Your View list, click Message Timeline. 

The view changes to display message headers in a timeline. 

9 In the Change Your View list, scroll to the top, and click Messages. 

The view returns to Messages—the default view. 

Sorting Messages 

You can quickly manage many messages by sorting them. Sorting arranges the 

messages in your Inbox by the criteria you specify. You can sort according to 

age (how long the message has been in your Inbox), size, importance, and 

more. You can sort messages in either ascending order (A to Z) or descending 

order (Z to A), by a specific field, or by a column header that appears at the top 

of a view’s table, such as subject, sender, or flag status. When you sort in a 

view, the messages remain in the same view; however, they are displayed in a 

different sequence. 

For example, the human resources manager at Adventure Works returned from 

vacation to find that her Inbox contained hundreds of unread messages. She 

wanted to reply to the most important messages, so she sorted the contents of 

her Inbox by order of importance. The messages marked with high importance 

appeared at the top of the list in ascending order. After she replied to the  

You can’t sort messages in 

the timeline view. 
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high-priority e-mail messages, she wanted to reply to the remaining e-mail 

messages in the order they were received. She sorted her Inbox again, clicking 

the Received column heading. 

You can sort by four fields at the same time, thus performing a sort within a 

sort. When you perform a second sort on messages that have already been 

sorted, the second sort further organizes the list of sorted messages. For 

example, if you sort your Inbox by Subject in ascending order and then sort by 

Attachment in descending order, the Inbox will be sorted by Subject. Within 

the subjects, messages with an attachment will appear first. 

In this exercise, you sort the list of messages in your Inbox by Attachment and 

by Subject. You clear the sort to complete the exercise. 

1 Open the View menu. Point to Current View and click Customize 

Current View. 

The View Summary dialog box is displayed. 

 

2 Click the Sort button. 

The Sort dialog box is displayed. 

Sorting does not remove 

messages from view. To 

temporarily remove 

messages from view, you 

must apply a filter. See 

“Filtering a View” in this 

lesson. 
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3 In the Sort items by section, select Attachment, and verify that the 

Descending option is selected. 

4 Click OK twice. 

The messages with attachments are displayed at the top of the 

message list.  

5 Open the View menu. Point to Current View and click Customize 

Current View. 

The View Summary dialog box is displayed. 

6 Click the Sort button. 

The Sort dialog box is displayed. Notice that Attachment still 

appears in the Sort items by box. 

7 In the Then by section, click Subject. If necessary, click the 

Descending option. 

8 Click OK twice. 

The messages with attachments still appear at the top of the 

message list and are sorted by subject in descending order (Z to 

A). (Outlook ignores the text FW: and RE: in the subject and uses 

the first letter that appears after the text FW: and RE: to sort by the 

subject.) 

9 In the top of the Organize pane, click the Customize Current View 

button. 

The View Summary dialog box is displayed. 

10 Click the Sort button. 

The Sort dialog box is displayed. 

If necessary, scroll up 

through the Inbox to see the 

messages at the top of the 

list. 

When messages are sorted 

in the Inbox, a small arrow 

appears in the associated 

column heading to indicate 

whether the messages are 

being sorted in ascending or 

descending order. The arrow 

points upward if messages 

are sorted in ascending 

order, and the arrow points 

downward if messages are 

sorted in descending order. 

You can also sort messages 

by clicking the column 

heading. 
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11 Click the Clear All button. 

The sort criteria are removed. 

12 Click OK twice. 

The message headers are no longer displayed in the sort criteria 

you specified. 

Creating Folders 

A folder organizes stored messages or other files and Outlook items. When you 

first start Outlook, several folders already exist, including the Inbox (where 

new e-mail messages appear), Sent Items (which contains copies of messages 

that you’ve already sent), Drafts (where unfinished messages are stored), and 

Deleted Items (which contains items that you deleted from other Outlook 

folders). You can create your own folders—such as folders for coworkers, 

managers, or projects—to organize messages more effectively. 

When you create a folder, you must consider where the folder is to be placed. 

Most Outlook folders are located within one or more other folders. For 

example, the Inbox folder is located in the Outlook Today folder. Display the 

Folder List to see which folders are inside other folders. 

important 

A folder created in Outlook must contain only a specific type of Outlook 

item—such as mail items only or contact items only. You identify the type of 

item that can be placed in the folder when you create the folder. Any item 

moved to this folder is converted to that type of item, regardless of how the 

item was originally created. For example, if you create a folder to hold mail 

items, and then move a task to the folder, a message window will appear 

with task information displayed in the subject and message area. The To 

box is empty, ready for you to address the message that contains 

information about the task and send it. 

When creating a folder, you can also create a shortcut to the folder on the 

Outlook bar. Creating a shortcut is especially useful if you plan to open and use 

the folder often. 

In this exercise, create a new folder named Parties, which will be used to store 

all messages that you receive about upcoming Adventure Works parties. 

1 In the Organize pane, click the Using Folders link. 

The Using Folders section of the Organize pane appears. 
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2 In the top of the Organize pane, click the New Folder button. 

The Create New Folder dialog box is displayed. 

3 In the Name box, type Parties. 

Notice that Mail Items appear in the Folder Contains box. 

4 Verify that Inbox is selected in the Select where to place the folder 

list and click OK. 

The folder is created. 

 

5 Click Yes when the Add shortcut to Outlook Bar dialog box is 

displayed. 

The Parties folder is created. The My Shortcuts group bar on the 

Outlook bar flashes for a few seconds as the Parties shortcut is 

moved to the My Shortcuts group. 

6 On the Outlook bar, click the My Shortcuts group bar. 

The Parties shortcut is located on the Outlook bar. 
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7 On the Folder Banner, click the folder name Inbox. 

The Folder List appears. 

8 If necessary, in the Folder List, click the plus sign (+) to the left of 

Inbox. 

Notice that, although the folder has been added to the My Shortcuts 

group, the folder is located in the Inbox folder. 

9 Click outside the Folder List. 

The Folder List closes. 

Moving Messages Between Folders 

When you want to organize many Outlook items with similar subjects or 

content, you can group the items together in a folder. Folders not only store the 

items, but other folders can be created within the folder to further subdivide 

items more specifically. This system of organization can be helpful when you 

have a large project that requires many items dealing with many subjects. For 

example, the training director at Adventure Works has a folder for messages 

regarding training. This folder is further subdivided into folders for messages 

regarding each training class. You can use four different methods to move a file 

from its current location to another folder: Drag the message from its current 

location to a folder, click the Move To Folder button on the Standard toolbar, 

use the Move Message option in the Using Folder section of the Organize pane, 

or create a rule to automatically move messages from one folder to another. 

You will add messages to this 

folder in the next exercise. 
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You can manually move a selected message into a folder by dragging the 

message from the Inbox (or its current location) to the desired folder. Dragging 

is convenient if you want to move a message to a folder that is visible in the 

Outlook window. Messages can be dragged to folders (represented by icons) on 

the Outlook bar and in the Folder List. For example, if you receive a message 

in your Inbox and want to move it to the Notes folder, drag the message header 

onto the Notes shortcut on the Outlook bar. 

Click a message header and click the Move To Folder button on the Standard 

toolbar to open a menu of available folders. The list of folders on the menu 

changes to reflect folders based on the number of times they are selected. For 

example, if you frequently move messages to the Picnic folder but never move 

them to the Tasks folder, the Picnic folder is displayed on the menu, but the 

Tasks folder is not listed. 

The Using Folders section of the Organize pane contains a Move Message 

option that moves selected messages to a folder. Like the Move To Folder 

button, select the message or messages and choose the folder from the Move 

Message list. This method is convenient if you just created a new folder in the 

Organize pane. 

In the Using Folders section of the Organize pane, you can also create a rule (a 

set of conditions, actions, and exceptions that perform a particular process) so 

that a message from a particular address is moved to a particular folder. 

Creating this rule is an easy way to organize messages if you always want to 

perform the same action. For example, the head chef of the Adventure Works 

frequently receives recipes from a friend. To help him stay organized, the chef 

created a rule so any e-mail messages he receives from this friend are moved to 

his Recipes folder. With this rule, the chef doesn’t have to sort through his 

Inbox for new recipes; he can simply access any recipe messages in the Recipes 

folder. 

When you no longer want to 

use a rule, click the Rules 

Wizard button in the Using 

Folders section of the 

Organize pane and delete  

the rule. 
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tip 

After you send a message, Outlook saves a copy of the message in the 

Sent Items folder. However, you can create a rule that copies sent 

messages to a different folder. For example, create a rule that copies all the 

messages you send to your supervisor into a folder named Supervisor.  

In this exercise, you move messages into the Parties folder, create the Class 

folder, and create a rule that moves messages received from your class partner 

to the Class folder. You send a message to your class partner to test the rule. 

Finally, you use the Rules Wizard to delete the rule. 

1 In the Inbox, select all messages sent in previous exercises about 

Mike’s birthday party. 

The messages are highlighted. 

2 In the Using Folders section of the Organize pane, verify that 

Parties is displayed in the Move messages selected below to box. 

3 Click the Move button. 

The messages are moved to the Parties folder. They are no longer 

displayed in the Inbox. 

4 In the My Shortcuts group on the Outlook bar, click the Parties 

shortcut. 

The Party messages are displayed in the Parties folder. 

5 On the Standard toolbar, click the Organize button. 

The Organize pane is displayed. 

6 In the top of the Organize pane, click the New Folder button. 

The Create New Folder dialog box is displayed. 

7 In the Name box, type Class. 

8 Verify that Inbox is selected in the Select where to place the folder 

list and click OK. 

The folder is created. 

9 Click Yes when the Add shortcut to Outlook Bar dialog box is 

displayed. 

The Class folder is created and the Class shortcut is added to the 

My Shortcuts group on the Outlook bar. 

10 In the Organize pane in the first Create a rule to move new 

messages box, verify that the word from is selected. 

11 If necessary, in the next box, type your class partner’s e-mail 

address. 

12 Verify that the Class folder you just created is selected in the last 

box for the rule. 

If you move a message into 

the wrong folder, immediately 

after you’ve moved it you can 

click Undo Move on the Edit 

menu to move the message 

back to its previous location. 
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13 Click the Create button. 

An alert box is displayed. The new rule will be applied to incoming 

messages. The alert box also asks if you would like the rule to be 

applied to the current contents of this folder. 

14 Click No so that the rule is not applied to the current contents of the 

folder. 

The rule is created. Messages sent from your class partner will be 

sent to the Class folder. 

15 On the Standard toolbar, click the New Mail Message button. 

A message window is displayed. 

16 In the To box, type your class partner’s e-mail address. In the 

Subject box, type Testing, and in the message area, type Is this 

message in the Class folder? 

17 On the Standard toolbar in the message window, click the Send 

button. On the Standard toolbar, click the Send/Receive button. 

A message from your class partner arrives, and it is automatically 

moved to the Class folder. 

18 In the My Shortcuts group on the Outlook bar, click the Class 

shortcut. 

The Testing message header is displayed in the Class folder. 

19 On the Standard toolbar, click the Organize button, and click the 

Rules Wizard button at the top of the Organize pane. 

The Rules Wizard is displayed. The rule you created is selected in 

the Apply rules in the following order box. 

20 Click the Delete button, click Yes in the alert box to confirm the 

deletion, and click OK. 

The rule is no longer applied to the messages sent by your class 

partner. 

Filtering Junk E-Mail Messages 

Junk e-mail (unsolicited and unwanted e-mail, also known as spam) is an 

annoying problem for many Internet users. Junk e-mail can fill an Inbox with 

dozens, even hundreds, of advertisements, chain e-mails, and other nuisances. 

Unfortunately, many individuals and companies use junk e-mail as a major 

marketing tool because it is so inexpensive. Another form of junk e-mail is 

unsolicited messages with adult content that might be offensive or 

inappropriate for some people. 

Outlook includes built-in junk e-mail filters that identify e-mail messages 

containing text and message headers identified by Microsoft as common to 

junk e-mail. Messages with terms common to junk e-mail—such as SPECIAL 

PROMOTION, $$$, and Money back guarantee—can be color-coded, moved to 

a different folder, or deleted. This system of identifying junk e-mail prevents 

your Inbox from becoming cluttered with junk e-mail and enables you to 

A list of the terms Outlook 

uses to filter suspected junk 

e-mail messages is provided. 

The location of this 

information depends on your 

operating system. Use the 

Search function in Windows 

Explorer. Search for files or 

folders with the term filter in 

the name.  
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review the filtered messages at your convenience or automatically delete the 

messages. 

Outlook also includes a separate category of filters to identify messages 

suspected of having adult content. As with the junk e-mail filters, messages 

with terms common to adult content messages, such as over 21 and adults only, 

can be color-coded or moved to a different folder. 

The junk e-mail and adult e-mail filters will not catch all junk or offensive 

messages, however. Those who send junk e-mail frequently revise their 

message text and message headers to use text that is not identified as junk or 

adult content, bypassing the filters. If you find that you are receiving many junk 

e-mail messages and the filters are not effective, add new junk e-mail addresses 

to the filter. Right-click one of the messages and click Junk E-mail on the 

shortcut menu. 

You can also add new junk e-mail addresses to the filter in the Organize pane. 

Specify the color used to identify junk e-mail message headers and message 

headers with adult content. When you receive these messages, you will 

recognize the color and you can delete the messages without reading them. 

tip 

Use the click here link in the Junk E-Mail section to download new junk  

e-mail filters. 

In this exercise, you turn on the Junk E-Mail message filter to color-code junk 

e-mail teal and add an address to the Junk E-Mail Senders list. 

1 In the Organize pane, click the Junk E-Mail link. 

The Junk E-Mail section of the Organize pane is displayed. 

 

2 Select Color in the first box.  

This identifies the action Outlook should perform when junk e-mail 

is detected. The message can be moved or color-coded. 

3 Select Teal in the second box. 

This identifies the color code for the messages. If you select the 

move option in the first box, you select the destination folder in this 

field. 

4 Click the Turn On button. 

The Junk E-Mail filter is activated. The pane changes to say New 

Junk messages will appear Teal. The label of the Turn on button 

becomes Turn off. The message from Spammer is color-coded. 



Lesson 6 Customizing E-Mail 6.27 

5 Double-click the Vigor Airlines message header. 

This is junk e-mail. However, Outlook did not recognize it as junk e-

mail. 

6 In the top-right corner of the message window, click the Close 

button. 

The message closes. 

7 Right-click the Vigor Airlines message header. 

A shortcut menu is displayed. 

8 Point to Junk E-Mail, and click Add to Junk Senders list. 

An alert box is displayed. 

 

9 Click OK. 

Any message that you receive from this company will automatically 

be colored teal. 

10 In the bottom of the Organize pane, click the click here link. 

More junk e-mail options appear. 

 

11 On the second line, click the Edit Junk Senders link. 

The Edit Junk Senders dialog box is displayed. The e-mail address 

of Vigor Airlines has been added to the junk e-mailers list. 
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12 Click OK. 

13 On the last line of the Junk E-Mail window, click the Back to Junk 

E-Mail link. 

The original junk e-mail options are redisplayed. 

Lesson Wrap-Up 

This lesson covered how to customize your e-mail messages and organize  

your Outlook Inbox. You learned about e-mail options such as importance, 

sensitivity, and delivery options. You also learned how to customize the 

appearance of your e-mail messages by creating them in Plain Text, Rich Text, 

and HTML formats. You learned about creating signature. You learned how to 

set viewing options and sort the Inbox. You learned how to create a folder and 

move messages between folders. In addition, you learned how to organize your 

Inbox by filtering junk e-mail. 

If you are continuing to the next lesson: 

■ On the Standard toolbar, click the Organize button. 

The Organize pane closes. 

If you are not continuing to other lessons: 

■ In the top-right corner of the Outlook window, click the Close 

button. 

The Outlook window closes. 

Quick Quiz 

1 How do you assign high-importance status to a message? 

2 What is a view? 

3 What is one way to distinguish messages from a specific person? 

4 What is a signature in an e-mail message? 

5 How can you store outdated messages? 

Several organizations fight 

junk e-mailers by alerting 

government authorities to 

illegal spamming and 

promoting legislation to 

restrict junk e-mail. Search 

for them with your Web 

browser using the keywords 

spam or junk e-mail. 
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6 What can you use to format a message with a predefined design? 

7 What levels of importance does Outlook let you set for a message? 

8 Where in Outlook do you filter junk e-mail? 

Putting It All Together 

Exercise 1: The new marketing director at Adventure Works needs to set up 

his e-mail workspace. First, create two folders for the new projects—Pool and 

Tennis Courts—starting next week. Place these folders in the Inbox folder. 

Next, set up a business signature to include his name (Peters, James), title 

(marketing director), and phone number (555-555-0154). Set this signature as 

the default signature. Finally, the director has little time for junk e-mail, so set 

up the filters to identify and delete junk e-mail. 

Exercise 2: The general manager of Adventure Works wants to invite a new 

member of the staff to a manager’s meeting. Send an e-mail message to 

someone@example.com using the Formal Announcement stationery 

announcing the manager’s meeting on Tuesday, at 3:00 P.M., in the dining 

room. Indicate that the message is important. 

Exercise 3: Create a message that informs your customers that you have a 

new product. Use text and graphics to interest the customers in the new 

product. 

Exercise 4: Locate the Outlook file used to filter junk e-mail. Add several 

additional phrases to the list. 


